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About this course
Objectives of the course
Upon completion of this course you will learn
- How to use the Shape Sculptor application
- How to import, analyze, enhance meshes
- How to modify them by adding details or deforming shapes

Targeted audience
Style designers, Modelers

Prerequisites
Students attending this course should have knowledge of CATIA V5
Fundamentals

1 Day
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Introduction to CATIA Shape Sculptor
In this lesson, you will see some general information about :

Process overview
Polygon Modeling
Accessing the Workbench
The User Interface
Using the Compass
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Process overview

Digitized data

Polygon modeling

Tooling design NC ManufacturingRapid Prototyping Feasibility 
studies

New mock-up

In early phases of iterative design cycle

A rough model has been created: mock-up, 
prototype,…
The design is validated
Next step: tune shape + add details
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Polygon Modeling

Modify shape 

Polygon modeling = work on a polygon (a mesh) on screen as if working on a physical mockup.
Benefits: working on a screen is cheaper and the result is directly usable in CATIA

Analyze shape Add details
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Accessing the Workbench

At any time, the current workbench is 
indicated by an icon on the right hand 
side of the screen.
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The User Interface
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Using the Compass (1/3)

Select a plane or direction to perform an action 
Make it a privileged plane
Apply a transformation to one or several entities.

In this toolbar you have the choice of 
the main plane/direction

Activate the main plane that is the most 
visible on your viewing position

Use a plane or 3 points to define a 
plane or direction

Reset the compass in xyz mode

Switch the compass from not linked to 
linked to the entity

When linked to an entity, create the 
compass plane for later use

Hit F5 several times to switch from x0y to y0z then to z0x.
The compass also has an associated popup

The compass is used to:

This toolbar helps to swap from one 
selection to another
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Using the Compass (2/3)

A curve: The plane normal to the curve will be defined.
A surface: The plane tangent to the surface where you dropped the compass will be defined.

Once a plane or direction is selected, you may use its definition in 
relevant action.
Each time you find the following icon, use it to project control
points within the “Control Point” menu

Positioning the compass: You may drag and drop your compass to:

The compass is then switched from x,y,z to a u,v,w trihedron.
Then by hitting F5 you will flip from u,v to v,w then w,x plane definition.
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Using the Compass (3/3)

Link the compass to an entity and then use the axes/rotation circles from the compass, the 
entity will physically move in your model
You can also manipulate several entities: first position your compass on an entity, then 
multi-select the entities to be moved and act on the compass
To reset the compass drag and drop it on the absolute xyz axis (lower right of the screen)

Apply a transformation to one or several entities:

Z translation

Y rotation

X rotation

X translation

Z rotation
Y translation

Display according to a main plane:
Just click the x, y or z letter to display the corresponding y0z, z0x and x0y view
Click the same letter again to reverse the view direction 
Pan the display by click+hold on x,y or z axis and moving the mouse 
Rotate the display by click+hold on the arcs of circle and moving the mouse
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General Tools
In this lesson, you will learn about:

Import
Export
Display options
Highlight
Curvature
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Import (1/2)

You can read any mesh available in STL format (text or binary)
STL format was originally designed for rapid prototyping by 
stereolithography but it has become a common exchange 
format for triangular meshes
The Import command of Shape Sculptor is the same as 
in DSE but limited to STL meshes
Meshes can be imported from a file stored in an ENOVIA or a 
SMARTEAM base

• Sampling: not available for 
the import of meshes.

• Scale Factor: the scan 
operation is very often 
performed on a scaled 
model, you may want to 
work on real size model, 
apply the given scale factor

• File Unit: your CATIA 
session is set up for a given 
unit. The file you import 
comes from the outside 
world and may be digitized 
in another unit. Set up the 
proper unit before importing 
the file

• Get information in the statistics window (number 
of points, mesh dimensions…)

• If you recall several meshes you may 
choose to group them into a single mesh

• You may 
preview the 
imported 
mesh and 
select a part 
of it by a 
containment 
box
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Import (2/2)

The ‘ More…’ button gives access to advanced possibilities
Warning: you have to click Apply before you can close the dialog box by OK
If you click Cancel the selected mesh is not imported

• System applies to the operating system 
(Unix or Windows NT) used to generate 
the binary data: select Same if you 
know you are using the same operating 
system as the one used to generate the 
binary data, Other for the other way, 
Unknown if you have no indication.

• Free Edges is used to create or not the 
scans representing the free edges of a 
cloud of points.

• Facets: not available in Shape Sculptor 
environment
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Export

You can export a mesh to a new STL file or export its vertices only to a new cloud of points  

!
! ASCII generated by Digitized Shape Editor/CATIA
!
! Without Scans
! Point Format           = 'X %f Y %f Z %f'
!
! Total number of points = 5453        
!
X 0.580073 Y -0.500810 Z -0.383616
X 0.580837 Y -0.499042 Z -0.385223
X 0.580386 Y -0.504416 Z -0.382684
X 0.590524 Y -0.487657 Z -0.377479
X 0.583682 Y -0.501518 Z -0.386112
X 0.588214 Y -0.494585 Z -0.373934
X 0.583410 Y -0.505760 Z -0.384708
X 0.588975 Y -0.505897 Z -0.370677
X 0.592607 Y -0.485534 Z -0.373024
X 0.598624 Y -0.496144 Z -0.380670
X 0.584484 Y -0.504205 Z -0.385984
X 0.590717 Y -0.492391 Z -0.369409
X 0.602287 Y -0.494163 Z -0.375520
X 0.598038 Y -0.509153 Z -0.376080

CGO:

285
431.198151 -674.281799 107.692230
431.198151 -674.628418 108.223984
431.198151 -675.001831 109.109077
431.198151 -675.635742 110.533531
431.198151 -676.545776 112.480850
431.198151 -677.638306 115.074150
431.198151 -677.688721 115.194672
431.198151 -677.732605 115.291199
431.198151 -679.014343 118.206978
431.198151 -680.101318 120.927452

Save as Type: 
•Ascii free: point coordinates according 
to ISO standard
•Ascii RGB: point coordinates + RGB 
color code for each point
•Cgo: point coordinates only, readable 
in CATIA V4 CGO application.
•Stl: binary STL file. 

Axis system: export mesh in Absolute 
or Current axis system

Multi-selection available to export several 
meshes to several files (option Distinct) or 
to a single file (option Grouped).
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Display options

The Cloud Display Options is the same as in DSE but
it is limited to the options which apply to meshes.
The options can be found from the properties of mesh.

For meshes there are 6 options which can be combined: 
•Triangles: To display the facet edges
•Vertex: To display the vertices (nodes) of the mesh
•Flat: Shaded display of the facets, each facet has a uniform color, it 
is an exact display
•Smooth: Shaded display with Gouraud shading, the surface looks 
smoother than it is
•Free Edges: To display the mesh boundaries (useful to detect holes)
•Non-manifold: To display non-manifold edges (edges shared by 
more than 2 facets)

Triangles Smooth Flat Smooth + Triangles Smooth + Vertex Smooth + Free Edges

All the colors, the edge line types and the vertex markers can be changed by Edit/Properties.
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You can activate a light source manipulation tool 
to tune and animate the highlight lines.

Highlight

The Highlight analysis option of FreeStyle is available in Shape Sculptor
It requires the display mode to be turned to Shading with Material
A manipulator is displayed and can be used to tune 
or animate the highlight lines 

You can simulate the reflection of parallel 
stripes (default) or the reflection of a grid:

You can also display lines corresponding 
to a constant angle step 

You can activate anti-aliasing to smooth 
the highlight lines

The line density (number of lines), thickness (width) and 
sharpness (blur) can be controlled

The analysis can be 
applied to a mesh or 
to the whole part
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Curvature

Shape Sculptor offers a specific curvature display tool
It computes a smooth distribution of the curvature from the flat facets and shows it according to 
a color scale.
The values corresponding to the color threshold can be tuned with sliders.
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Selection and Activation
In this lesson you will learn about:

Selecting vs Activating
Brush Select
Box Trap
Curve Select
Hole Select
Flood Select
Invert Select
Activate
Activate All
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Selection (1/2)

Mesh

Selected area

Only area is refined

Only area is deleted

Only the area is activated 
The rest is ignoredActivated area

Mesh

Selection is used to choose the area of the mesh on which you want to apply an action.
Examples:

As in Digitized Shape Editor and Quick Surface Reconstruction workbenches you can activate 
a part of a mesh. Activation is used to extract the part of the mesh on which you want to work, 
the rest is temporarily hidden and cannot be accessed unless it is reactivated.

Example:
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The selection of a mesh area can be done by various methods:

Brush select: the brush is shown as a circle, its radius
can be changed, brushed facets are selected and
highlighted

Box trap: the facets included to the 3D trap are selected

Curve select: the facets located inside a closed set of curves
are selected.
The control key must be used for the multi-selection of curves.

Hole select: the free sides of the mesh are highlighted and 
can be selected.

Flood select: a whole continuous domain is selected

Invert select: selected and non-selected facets are swapped

Selection (2/2)
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A selected area can be activated

Activate: The selected elements are kept, the others are made invisible

Activate All: The whole mesh is redisplayed

Activation

Activation can also be done with the Activate command of Digitized Shape Editor (DSE) or Quick 
Surface Reconstruction (QSR)
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Creation
In this lesson, you will learn about:

Creating Curves
3D Curve
Paint Curve
Creating Meshes
Generate Mesh
Tessellate
Rough Offset
Boolean Operations
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Creating Curves

In Shape Sculptor curves may have various different objectives: 

Define the limits of an area to select
Example: Curve Select

Define the shape of a modification
Example: Curve Sculpt

Define the limits of a shape deformation
Example: Emboss, Push/Pull
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3D Curve (1/2)

Select existing points on a 
mesh or on any existing 
element (curve, point…) or 
select new points taken in 
the current privileged plane 
(defined by the compass)

• Creation type: 3 options
available

• Points handling: you can add or remove a 
point, or add or remove a constraint between a 
point and a support element.

• Disable geometry detection: selected points are 
taken in the current plane even when an 
element is selected.

• Options: smoothing parameters available with 
the option “ Near points”

• Smoothing options: also available with option
“Near points”

UniformChord length

The same 3D Curve tool as in DSE, QSR or FreeStyle is available in Shape Sculptor
It can be used to draw curves directly on a mesh
Warning: only selected points are exactly on the mesh.
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When a point is constrained on a 
curve you can move it along the 
curve with manipulators.

Right-click a point:

- to edit its position in space or on 
its support element

-to impose a tangency or a 
curvature

- to remove or constrain the point

3D Curve (2/2)

Right-click the curve tangent 
(green arrow) to access tangent 
definition options
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Paint Curve

Show/Hide dialog box with 
fitting parameters:

With/without fitting:

No fitting (polyline)

With fitting (smooth curve)

The Paint Curve command allows to draw a curve on a mesh.
You have to select the support mesh, then press the left button of the mouse and draw the curve 
on the mesh.
You can use CTRL key to create a closed curve.
You can double-click the last point to exit the command and create the curve (or use the OK 
button of the dialog box).
The command opens a specific toolbar:
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The mesh is the main object manipulated in Shape Sculptor
You may import a mesh, but you may also create additional meshes

To repair an existing mesh: fill a hole, replace a part of it,…

To convert a surface to a mesh and edit it with Shape Sculptor tools,

To create an offset mesh

Creating Meshes
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Generate Mesh

Selection of area to process
Trimming

Point and Curve tolerances: used for the 
computation of the temporary surface

Tessellation: used for the computation of 
the mesh from the surface

Generate Mesh can be used to tessellate points of an existing mesh
It is mainly used to correct defects, for example fill holes
The area to re-mesh has to be selected
A temporary surface is computed over the selected points, then it is tessellated to create a mesh
The created mesh is larger than the selected area, it has to be trimmed afterwards if needed
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Sag: maximum distance between mesh and support surface

Step: maximum edge length, to avoid long and thin triangles in flat areas

Tessellate

You can convert surfaces to meshes according to a given tolerance
This can be useful to switch from conceptual design to polygon modelling

no edge length edge length = 10mm
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Rough Offset

Granularity: accuracy of the computation.

•With a low granularity value: all details are taken into account, the 
resulting mesh counts many triangles.

•With a large value: the result is rough, some details may be lost.

A white arrow indicates the side for a positive offset value.

Rough Offset handles large offset values leading to drastic shape changes
You may offset the mesh on one or both sides
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Boolean Operations

You can perform Boolean operations on two meshes.
The meshes must be manifold and the intersection of the meshes must result in one or several 
closed contours.

Mesh A

Mesh B

Once you select the meshes, you can see two arrows. Each arrow shows the side of the other 
mesh that will be kept. The color of the arrow shows the orientation.

Green: Outside orientation

Red: Inside orientation You can define the operations 
between meshes by changing the 
arrow directions.
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Mesh Edition
In this lesson, you will learn about:

Editing Meshes
Decimate / Refine
Smooth / Brush Smooth
Delete / Extract / Copy Triangles
Slice / Stitch
Mesh Intersect
Trim / Split
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Shape Sculptor offers a variety of tools for mesh edition
These tools have different objectives:

Add or remove triangles

Optimize the data size, i.e. optimize the number of triangles

Improve mesh quality

Edit mesh using external elements

Editing Meshes

Delete Triangles

Extract Triangles

Copy Triangles

Decimate

Refine

Smooth

Brush Smooth

Slice

Mesh Intersect

Trim/Split

Stitch
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Decimate can be used to reduce the number of triangles in a mesh or in an area of a mesh               
(if it has been selected)

On the contrary you can Refine a mesh or an area of a mesh to increase the number of triangles
The elements to refine must have been selected first.

Decimate / Refine

When you click Apply each selected 
triangle is divided into 2 new triangles

You may choose between 2 modes: Chordal 
Deviation preserves the shape of the model 
while Edge Length gives a more uniform 
distribution of the vertices.

You can choose the objective of the 
decimation to be a Maximum edge length or 
simply a Percentage of the number of 
triangles.

You can activate the Free edge tolerance 
option to preserve the shape of the free edges 
(useful to maintain continuity with 
surrounding elements).

The Analysis option gives a feedback on the 
actual deviation between the original and the 
decimated mesh.
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Smooth can be used to correct shape defects on a mesh
Smoothing is done step by step until a correct result is reached
Warning: the mesh is actually modified, some points are moved

Brush smooth does the same in real time on triangles selected by brush

Smooth / Brush Smooth

Steps and Pressure : can be increased 
to accelerate the smoothing process
Preserve volume : use a smoothing 
method which avoids moving all points 
to the same side of the surface
Smooth boundaries : keep the shape of 
the free edges of the mesh
Deviation: information of the applied 
deformation
Tolerance: maximum accepted deviation 
for each click on the Apply button.

Radius : size of the brush used for selecting triangles
Pressure : smoothing strength (like above)

Type : similar to above volume preservation option
• Flatten: the smoothed area tends to get flat,
• Round: the smoothed area remains curved.
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Selected triangles can be Deleted, Extracted or Copied:

Delete : the selected triangles are 
deleted, leaving a hole in the mesh 

Extract : the triangles are deleted 
from the mesh but created as a 
new mesh

Copy : the selected triangles are 
created as a new mesh but they are 
not deleted from the mesh

Delete / Extract / Copy Triangles

+

+
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Slice : create new free edges along curves or scans
The mesh is divided into cells

On the contrary Stitch can be used to merge meshes 
You have to select the common free edges
You can specify a tolerance between the edges if they do not superimpose exactly.

Slice / Stitch

A cell can be selected by Flood Select to 
be activated, refined, ...

If the distance between the selected 
edges is greater than the tolerance 
the edges are not merged

1

2
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Mesh Intersect 

You can create the intersection between a mesh and a plane, a surface or another mesh
The intersection is created as a smoothed curve or can be used to slice the mesh
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Trim / Split

With Trim: you can select the area to keep 
or the area to remove by selecting the 
corresponding icon and clicking on the 
mesh

Remove All removes all the icons.

Projection specifies the 
direction to project the cutting 
curves or scans to the mesh

Preview shows the 
intersections between the 
selected mesh and cutting 
elements

Trim: the mesh is divided into 
sub-meshes and only selected 
areas are kept
Split: the mesh is divided and 
all sub-meshes are kept.

In all cases sub-meshes can be 
grouped into a single mesh or 
created as distinct meshes.

Keep initial: when active the 
input mesh is kept and made 
invisible.

You can cut a mesh by scans, curves, planes, surfaces or other meshes
The selected cutting elements must define non-ambiguous areas of the mesh, otherwise you get 
an error message
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Modeling Shapes
In this lesson, you will learn about:

Modeling Shapes
Control Points
Project Curves / Extract Curves
Curve Sculpt
Emboss
Push/Pull
Surface Sculpt
Sharp Edge
Grid Modeling
Interactive Grid Modeling
Mesh Morphing
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Modeling Shapes

Curve and Surface modification

Addition of details on shape

Global shape deformation

After editing the mesh you can use it as a support for modelling
In Shape Sculptor modeling means:

Add details
Or Modify the shape globally

In addition you may access the modeling tool of FreeStyle to modify curves and surfaces by their 
control points
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Control Points (1/2) 

Select the control points that are free to move (the others remain fixed)
Choose a direction for moving the control points that you drag
If several control points are free to move, define a deformation distribution law

Control Points are used to modify the shape of a surface

Choose the possible directions with the icons of the dialog box as follows:

Perpendicular to the privileged plane

Along directions defined by the segments connecting 
the control point

Parallel to the normal direction of the curve at 
the considered point

In the privileged plane (change the privileged plane 
if necessary)

Parallel to the tangent direction of the curve at 
the considered point

In a local plane automatically detected by the system to 
preserve tangency directions (for example to allow the 
surface to be tangent to its symmetric)
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Control Points (2/2) 

Define a deformation distribution law with the icons of the dialog box as follows:

All the selected points are equally moved

The deformation distribution on selected points is 
linear from the pulled point (maximum deformation) to 
the last selected point (no deformation)

The deformation law is concave, i.e. the 
deformation attenuates quickly (local deformation)

The deformation law is convex, i.e. the deformation 
attenuates slowly (more global deformation)

The deformation varies slowly at both ends and 
quickly in the middleThe possible directions are shown by 

green arrows when you bring your 
pointer close to a control point or a line. 

When you select and drag an arrow, the control point (or the line) 
becomes the dragged point (or line) and is moved in the direction of 
the arrow. The other selected points are moved according to the 
chosen deformation law.

A GSD point can be created by right-
clicking on a control point and selecting 
“Keep this point”.

Deformation performed on one of the connections is 
propagated on the others according to current diffusion 
and cross diffusion laws
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Project Curves / Extract Curves

Activate Fitting

Display fitting parameters

Select free side Move square handle with 
mouse to add cutting points

You can project curves to meshes
The projection direction can be defined:

With the compass
Or as being the view direction
Or as being the normal to the mesh

You can create free sides as curves
The curves can be interpolated or fitted depending
on the option chosen in the tool palette
Cutting points can be added by moving the square
handle along the free side
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Curve Sculpt

Control width

Control depth

Profile defines the shape of the 
groove

Dynamic: activate dynamic display of 
the result whenever you change a 
parameter.

Offset corresponds to the depth.

Show: display the handle to control 
width (cyan)
Uniform: the width can be constant 
or defined by several width values. 
If option is deactivated you have to 
use handles to add and set depth 
values.

Influence area corresponds to width.

Show: display the handle to control 
width (magenta).
Refine: to add facets and improve 
local mesh quality.
Uniform: the width can be constant or 
defined by several width values. If 
option is deactivated you have to use 
handles to add and set width values.

You can use a curve lying on a mesh to locally deform a mesh and create a groove or slot. 
The depth and width of the groove can be dynamically controlled
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Emboss

Depth handle in cyan

Width handle in magenta

Emboss can be used to create a boss or pocket 
The user interface is similar to the previous one
The direction needs to be specified
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Push/Pull

You can deform a mesh by pulling one of its vertices in a given direction
The deformation area is limited by a limit contour
The user interface is again the same as before (cyan handle for depth or height, magenta handle 
for width)
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Surface Sculpt

You can define a part of a mesh by a closed set of curves and modify it as if it was a surface   
with control points
The user interface is the same as the Control Points command 
The continuity between the deformed and non-deformed areas can be controlled.
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Sharp Edge

Sharp Edge can be used to re-create sharp edges that have been filleted
You have to specify the fillet width with the magenta handles
Then you must set the position of the sharp edge with the cyan handles
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Grid Modeling (1/2)

The concept of grid modeling is to immerse the mesh into a box and deform the mesh by 
deforming the box
You can choose the number of sections in each of the 3 directions of the box
Then you can deform the mesh by moving or deforming sections with graphic handles
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Grid Modeling (2/2)

Select family of sections to manipulate

Switch to face deformation mode 
(similar to Control Points)Move, scale or rotate sections

The dialog box offers a large number of possible modes
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Interactive Grid Modeling

Interactive Grid Modeling is similar to the previous command
The difference is that the modeling box is defined according to the screen directions instead of 
the principal directions
The mesh is selected by a trap which gives the three directions of the box
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Mesh Morphing

You can deform the mesh using the target elements.
The deformation area can be limited by a limit element.
You have to specify the fillet width with the magenta handles
Then you must set the position of the sharp edge with the cyan handles

Influence area corresponds to width.

Show: display the handle to control width (magenta).
Refine: to add facets and improve local mesh quality.
Uniform: the width can be constant or defined by several width values. If option is deactivated you 
have to use handles to add and set width values.
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Terrain Modeling
In this lesson, you will learn about:

Modelling Terrain
Mesh Enrichment
Z Level Mesh
Z Level Map
Multi-sections Slice
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Shape Sculptor offers a variety of tools to edit the mesh.
These tools have different objectives:

Mesh Enrichment

Z Level Mesh

Z Level Map

Multi-sections Slice

Modeling Terrain

You cannot see these commands in Insert menu by default.
You have to use one of these methods to see the toolbar

Select Tools > Customize
Right-click any icon in any toolbar
Select View > Toolbars
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You can improve the quality of meshes by inserting points from a cloud of points.

Mesh Enrichment 

Mesh: Mesh to be enriched.
Origin: The cloud from which the 
points are to be taken.

The parameters area corresponds to 
constraints.

Threshold: It is a maximum 
acceptable distance between the 
mesh and the points to be inserted. 
The points that are at a distance 
greater than this parameter are not 
inserted.
Direction: It is a projection direction 
of a cloud onto the mesh. You can 
select the direction from the 
contextual menu.
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You can create a mesh from a scan of points with respect of Z Level Stream. 
A Z Level is a scan of points with the same altitude.

The mesh passes through all points and respects the Z level stream.

Z Level Mesh
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Z Level Map (1/3)

Element: display the handle to 
control width (magenta).
Origin: It is a reference point to define 
the major and minor planes.

The parameters area corresponds to 
planes.

Lower Distance: It is a distance on 
the Z-Axis between the first (lower) 
plane and the origin point.
Step: It is a distance between two 
planes.
Number: It is a number of major 
planes. It is automatically computed 
to the upper limit of the input 
elements.
Sag: You can specify it if you have 
selected surfaces or volumes.

You can choose the colors of the major and minor planes.
You can hide or show the planes and annotations.

You can create planar sections of a mesh on major and minor planes.
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Z Level Map (2/3)

The resulting scans are projected on a reference origin plane to create a Z Level map 
with annotations.

You can change the display mode of the scan using the contextual menu.
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You can extract the major and minor scans.

Z Level Map (3/3)
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You can slice a mesh by other meshes. 
You can select more than one mesh at a time.
The intersection line between meshes must be closed.

Multi-sections Slice

The slices are computed and 
displayed in different colors.

Multi-section slices are created 
in the specification tree.
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To Sum Up

In this course you have seen:

How to use the  Shape Sculptor application
How to import, analyze, enhance meshes
How to modify them by adding details or deforming shapes

CONGRATULATIONS !

You have completed the fundamental training on Shape Sculptor


